All Things Photography

Stephen Patton
Agricultural Communications Specialist/Photographer
University of Kentucky

David Keto
Media Producer/Director
University of Wyoming

Ana Henke
Publications Supervisor and Graphic Designer, New Mexico State University

Digital Photography: Just the Basics

Presented by

Stephen Patton
Agricultural Communications Specialist/Photographer
University of Kentucky
What you should know about your camera:

- Where is your instruction manual
- What kind of memory card it uses
- How many megapixels
- What type of battery it uses
What you should know about your camera:
- Where is your instruction manual
- What kind of memory card it uses
- How many megapixels
- What type of battery it uses
What you should know about your camera:

• Where is your instruction manual

• What kind of memory card it uses

• How many megapixels

• What type of battery it uses
What you should know about your camera:

- Where is your instruction manual
- What kind of memory card it uses
- How many megapixels
- What type of battery it uses

Murphy's Memory Card Capacity Chart

<table>
<thead>
<tr>
<th>Camera</th>
<th>1.0 GB</th>
<th>2.0 GB</th>
<th>4.0 GB</th>
<th>8.0 GB</th>
<th>16 GB</th>
<th>32 GB</th>
</tr>
</thead>
<tbody>
<tr>
<td>6 Megapixel JPEG</td>
<td>300</td>
<td>600</td>
<td>1200</td>
<td>2400</td>
<td>4800</td>
<td>9600</td>
</tr>
<tr>
<td>8 Megapixel JPEG</td>
<td>270</td>
<td>540</td>
<td>1080</td>
<td>2160</td>
<td>4320</td>
<td>8640</td>
</tr>
<tr>
<td>9 Megapixel JPEG</td>
<td>255</td>
<td>510</td>
<td>1020</td>
<td>2040</td>
<td>4080</td>
<td>8160</td>
</tr>
<tr>
<td>10 Megapixel JPEG</td>
<td>225</td>
<td>450</td>
<td>900</td>
<td>1800</td>
<td>3600</td>
<td>7200</td>
</tr>
<tr>
<td>12 Megapixel JPEG</td>
<td>200</td>
<td>400</td>
<td>800</td>
<td>1600</td>
<td>3200</td>
<td>6400</td>
</tr>
<tr>
<td>15 Megapixel JPEG</td>
<td>150</td>
<td>300</td>
<td>600</td>
<td>1200</td>
<td>2400</td>
<td>4800</td>
</tr>
<tr>
<td>22 Megapixel JPEG</td>
<td>135</td>
<td>270</td>
<td>540</td>
<td>1080</td>
<td>2160</td>
<td>4320</td>
</tr>
</tbody>
</table>

*Approximate Number of Images Per Card*

*Exact Number of images will vary from camera to camera. Estimatoes based on "High-Resolution" camera settings with the least amount of JPEG compression. By shooting at the "Normal" or "Low" resolution you can approximately double the capacity of the card.*
Camera Settings

Know how to set:

- ISO = light sensitivity setting
- F-stop/Aperture
- Shutterspeed
- Image quality setting
- Image Size
- White Balance
- Colorspace
ISO = light sensitivity

- 100
- 200
- 400
- 800
F-stop/Aperture

The larger the opening, the less depth of field you have; meaning less viewing area in focus from front to back.
an infinity. The closest distance for that aperture is the scale on the lens barrel. The hyperfocal distance opposite is the one you are using. If you then set the depth of field with the focus at infinity. For your camera has a hyperfocal distance set at 18 feet.
Shutterspeed
1/500 of a second to stop action
1/30 of a second to blur action
Image quality setting

Quality  The size of the image

Approximate Values for Recording Pixels

<table>
<thead>
<tr>
<th>Recording Pixels</th>
<th>Purpose*</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>L</strong> (Large)</td>
<td>High</td>
</tr>
<tr>
<td>8M</td>
<td>3264 x 2448 pixels</td>
</tr>
<tr>
<td>Printing to about A3-size 297 x 420 mm (11.7 x 16.5 in.)</td>
<td></td>
</tr>
<tr>
<td><strong>M1</strong> (Medium 1)</td>
<td>5M</td>
</tr>
<tr>
<td>5M</td>
<td>2592 x 1944 pixels</td>
</tr>
<tr>
<td>Printing to about A4-size 210 x 297 mm (8.3 x 11.7 in.)</td>
<td></td>
</tr>
<tr>
<td>Printing to about Letter-size 216 x 279 mm (8.5 x 11 in.)</td>
<td></td>
</tr>
<tr>
<td><strong>M2</strong> (Medium 2)</td>
<td>3M</td>
</tr>
<tr>
<td>3M</td>
<td>2048 x 1536 pixels</td>
</tr>
<tr>
<td>Printing to about A5-size 148 x 210 mm (6 x 8.3 in.)</td>
<td></td>
</tr>
<tr>
<td><strong>M3</strong> (Medium 3)</td>
<td>2M</td>
</tr>
<tr>
<td>2M</td>
<td>1600 x 1200 pixels</td>
</tr>
<tr>
<td>Print postcard-size prints 148 x 100 mm (6 x 4 in.)</td>
<td></td>
</tr>
<tr>
<td>Print L-size prints 119 x 89 mm (4.7 x 3.5 in.)</td>
<td></td>
</tr>
<tr>
<td><strong>S</strong> (Small)</td>
<td>Low</td>
</tr>
<tr>
<td>0.3M</td>
<td>640 x 480 pixels</td>
</tr>
<tr>
<td>Send images as e-mail attachments or shoot more images</td>
<td></td>
</tr>
</tbody>
</table>
Compression

Approximate Values for Compression Settings

<table>
<thead>
<tr>
<th>Compression</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fine</td>
<td>Shoot normal quality images</td>
</tr>
<tr>
<td>Normal</td>
<td>Shoot more images</td>
</tr>
</tbody>
</table>

Lossy Compression
(Destructive)

Image Data Sizes (Estimated)

<table>
<thead>
<tr>
<th>Recording Pixels</th>
<th>Compression</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>L 3264 x 2448 pixels</td>
<td>3436 KB</td>
</tr>
<tr>
<td>M1 2592 x 1944 pixels</td>
<td>2503 KB</td>
</tr>
<tr>
<td>M2 2048 x 1536 pixels</td>
<td>1602 KB</td>
</tr>
<tr>
<td>M3 1600 x 1200 pixels</td>
<td>1002 KB</td>
</tr>
<tr>
<td>M 640 x 480 pixels</td>
<td>249 KB</td>
</tr>
<tr>
<td>M 1600 x 1200 pixels</td>
<td>—</td>
</tr>
<tr>
<td>W 3264 x 1832 pixels</td>
<td>2601 KB</td>
</tr>
</tbody>
</table>
**Economy**

**Good**

**Normal**

**Better**

**Fine**

**Best**

---

**Fine**

---

**Setting the Image-Recording Quality**

Set the recording quality to suit the intended image size for printing, etc. Note that the recording quality will also affect the number of shots the CF card can record. Select the recording quality while thinking about the capacity of the CF card to be used. Also see "Change to Image-recording Quality Settings" below and "FAQ" on the next page.

Select the image-recording quality:
- Under the [Rec] tab, select [Quality] and press 
- Set it to the desired recording quality such as [Fine], then press 
- [Quality] will be displayed.
- The figures (**** x *** ) displayed on the upper right is the actual pixel count (horizontal x vertical) for the respective quality setting.

**Guide to Image-recording Quality Settings**

<table>
<thead>
<tr>
<th>Quality</th>
<th>Pixels</th>
<th>Possible Shots</th>
</tr>
</thead>
<tbody>
<tr>
<td>A4</td>
<td>400k</td>
<td>49</td>
</tr>
<tr>
<td>A5</td>
<td>300k</td>
<td>49</td>
</tr>
<tr>
<td>A6</td>
<td>200k</td>
<td>49</td>
</tr>
<tr>
<td>B5</td>
<td>150k</td>
<td>49</td>
</tr>
<tr>
<td>B6</td>
<td>120k</td>
<td>49</td>
</tr>
</tbody>
</table>

* Applies to a SD/SDHC CF card.

* Except for the [ ] mode, the JPEG is used to record the image in all the recording quality modes.
White Balance

- Auto
- Daylight
- Cloudy
- Shade
- Flourescent
- Tungsten
- Tungsten

- sRGB
- Colormatch RGB
- Adobe 1998 RGB
- ProPhoto RGB
**Setting the Color Space**

The color space refers to the range of reproducible colors. With this camera, you can set the color space for captured images to sRGB or Adobe RGB. For normal images, sRGB is recommended. In the Basic Zone modes, sRGB is set automatically.

1. **Select [Color space].**
   - Under the [Rec] tab, select [Color space], then press <INFO >.

2. **Set the desired color space.**
   - Select [sRGB] or [Adobe RGB], then press <INFO >.

**About Adobe RGB**

This is mainly used for commercial printing and other industrial uses. This setting is not recommended if you do not know about image processing. Adobe RGB, and Design rule for Camera File System 2.0 (Exif 2.21).

Since the image will look very subdued with an sRGB personal computer environment and printers not compatible with Design rule for Camera File System 2.0 (Exif 2.21), post-processing of the image with software will be required.
The More Pixels the better

Image Size: Large (best quality)
Compression: Least = highest Quality
ColorSpace: Adobe RGB 1998

Good Composition

A pleasing arrangement of objects, mass, lines and contrasts of colors to form a harmonious whole
What makes a good photograph?

You Be the Judge
3 Essentials of a good photograph

- Good Technical Quality
- Interest or Impact
- Good Composition

Good Technical Quality

- No camera movement
  - Correct body position
- Correct focus
  - Person’s eyes
  - Selective/depth of field
- Lighting
  - Front, back, side
- Exposure
Interest or Impact

• Tell a story
• Express a mood
• Make a pattern

Good Composition

Get loser
SCUF
Shoot
Close
Up
For
Impact

Good Composition

- Get loser
- R .le cr Th'
- Get closer
- Rule of Thirds
- Vantage point
Good Composition

- Get closer
- Reflect Th
- Vanish
- Framing movement

Keys to Success

- Keep it simple
- Try vertical & horizontal
- Place subject off-center
- Try unusual points of view
iPhotography
Capturing, storing, processing, and distributing photos on iDevices

Different sensor sizes from Full Frame to 1/3.2-inch compared with each other
The sensor sizes usually used in smartphones are 1/3.2-inch or 1/3-inch, though the Nokia 808 used a 1/1.2-inch one

![Sensor Sizes Comparison](http://www.gizmag.com/camera-sensor-size-guide/26684/)

What different-sized sensors – Full Frame, APS-C, MFT, 1-inch, 2/3-inch, 1/2.3-inch, 1/3.2-inch – would have captured if using the same lens to take this photo

![Sensor Sizes Comparison](http://www.gizmag.com/camera-sensor-size-guide/26684/)
Understanding Pixels

<table>
<thead>
<tr>
<th>Typical Sensor</th>
<th>Resolution (WxH)</th>
<th>Print Size &amp; Quality</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Excellent @ 300dpi</td>
</tr>
<tr>
<td>3 MP</td>
<td>2048 x 1536</td>
<td>7” x 5”</td>
</tr>
<tr>
<td>4 MP</td>
<td>2464 x 1632</td>
<td>8” x 6”</td>
</tr>
<tr>
<td>6 MP</td>
<td>3008 x 2000</td>
<td>10” x 8”</td>
</tr>
<tr>
<td>8 MP</td>
<td>3264 x 2448</td>
<td>12” x 8”</td>
</tr>
<tr>
<td>10 MP</td>
<td>3872 x 2592</td>
<td>13” x 9”</td>
</tr>
<tr>
<td>12 MP</td>
<td>4290 x 2800</td>
<td>15” x 10”</td>
</tr>
<tr>
<td>16 MP</td>
<td>4920 x 3264</td>
<td>17” x 11”</td>
</tr>
<tr>
<td>35mm Film (Scanned)</td>
<td>5380 x 3620</td>
<td>18” x 12”</td>
</tr>
<tr>
<td>36 MP</td>
<td>7360 x 4912</td>
<td>24” x 16”</td>
</tr>
</tbody>
</table>

WWW.DIGITALPHOTOGRAPHYLIVE.COM

Front Camera Trouble

<table>
<thead>
<tr>
<th>Model</th>
<th>Front Camera</th>
<th>Rear Camera</th>
</tr>
</thead>
<tbody>
<tr>
<td>iPhone 5s/5c</td>
<td>1280 x 960</td>
<td>3264 x 2448</td>
</tr>
<tr>
<td>iPhone 4s</td>
<td>640 x 480</td>
<td>3264 x 2448</td>
</tr>
<tr>
<td>iPhone 4</td>
<td>640 x 480</td>
<td>2592 x 1944</td>
</tr>
<tr>
<td>iPad 4</td>
<td>1280 x 960</td>
<td>2592 x 1944</td>
</tr>
<tr>
<td>iPad 3</td>
<td>640 x 480</td>
<td>2592 x 1944</td>
</tr>
<tr>
<td>iPad mini</td>
<td>1280 x 960</td>
<td>2592 x 1944</td>
</tr>
<tr>
<td>iPad mini 2</td>
<td>1280 x 960</td>
<td>2592 x 1944</td>
</tr>
<tr>
<td>iPad 2</td>
<td>640 x 480</td>
<td>1280 x 720</td>
</tr>
</tbody>
</table>
### Social Numbers

<table>
<thead>
<tr>
<th></th>
<th>Facebook</th>
<th>Twitter</th>
<th>Instagram</th>
<th>Flickr</th>
<th>Dropbox</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Max Photo Size</strong></td>
<td>2048 x 2048px</td>
<td>1024 x 2048px</td>
<td>2048 x 2048px</td>
<td>200 MB</td>
<td>150 MB</td>
</tr>
<tr>
<td><strong>Max Photos</strong></td>
<td>1000 per album</td>
<td>100 shown</td>
<td>unlimited</td>
<td>1 Terabyte</td>
<td>2 GB</td>
</tr>
<tr>
<td><strong>Max Print Size</strong></td>
<td>4x6 – 8x10</td>
<td>4x6 – 8x10</td>
<td>6x6</td>
<td>unlimited</td>
<td>unlimited</td>
</tr>
<tr>
<td><strong>Need account to view?</strong></td>
<td>YES</td>
<td>NO</td>
<td>YES</td>
<td>NO</td>
<td>YES</td>
</tr>
</tbody>
</table>
How To Grab Still Images From Video

Presented by

David Keto
Media Producer/Director
University of Wyoming
How to grab still images from video

Freeze Frame Rules of Thumb

• Pick a frame with limited to no motion

• Pick a frame where your talent looks good

Freeze Frame Rules of Thumb

• Freeze frame is usually 72 DPI, so use it for web and smaller photos in print
How to Create a Freeze Frame

• Depends on software available
• JPEG is the most common output

How to Create a Freeze Frame

• In any program position the “playhead” on the frame you would like to grab a still from, be sure the video is paused

• Usually you can use the arrows to toggle back and forth to find the exact frame you would like
How to Create a Freeze Frame

- **Windows Media Player**
  - Control+!

- **Windows Movie Maker**
  - Tools
  - Take picture from preview

- **iMovie (not easy in latest versions)**
  - Put single frame you want to freeze in a new sequence
  - Export to quicktime
  - Movie to image sequence

---

How to Create a Freeze Frame

- **Final Cut Pro 7**
  - Export > using quicktime conversion
  - Format > still image

- **Final Cut X**
  - File > Share > Save CurrentFrame
  - *requires enabling "save current frame" in the "destination" options first
How to Create a Freeze Frame

• **Adobe Premier**
  – Click "export frame" button
  – *requires enabling "export frame" button first

• **Adobe Premier Elements**
  – Action bar: tools>freeze frame
  – Click export

How to Create a Freeze Frame

• **Quicktime (windows)**
  – Export>movie to picture or
  – File>print>PDF

• **iPad/iPhone**
  – Home+Power
  – Various apps for screen shooting
How to Create a Freeze Frame

• **Windows Screen Shot**
  - Windows+print screen (full screen)
  - Alt+print screen (selected window)

• **Mac Screen Shot**
  - Command+shift+3 (full screen)
  - Command+shift+4 (selected area)

---

Essential Graphic Design Concepts

Presented by

Ana Henke
Publications Supervisor and Graphic Designer
New Mexico State University
Essential Graphic Design Concepts

Resolution

- The amount of information or pixels contained in an image.

- Resolution is measured in DPI (dots per inch) or PPI (pixels per inch). These are literally the number of dots or pixels that can be placed side by side in a line one inch long. The more dots or pixels, the better the clarity – the higher the resolution – of the image.

Essential Graphic Design Concepts

Dots Per Inch (DPI)

The image on the right shows you the actual DOTS that are used to print a photograph on a printing press.
Essential Graphic Design Concepts

Resolution: Why is it SO important for printing?

![high resolution image](image1.png) ![low resolution image](image2.png)

high resolution  low resolution

---

Essential Graphic Design Concepts

Resolution: How do you know when an image has high resolution?

**Tip 1:**

Photoshop, a photo editing software, allows you to open the image file and look up the resolution. It should be 300 dpi or higher.
Essential Graphic Design Concepts

Resolution: What if you don’t have Photoshop?

**Tip 2: Image is probably low resolution:**
- if the placed or inserted image is SO small you have to enlarge it.
- if the image’s file size is smaller than 500KB (kilobyte).

**Tip 3: Image is probably high resolution:**
- if the placed or inserted image fills the page
- if image is at least 1MB (megabyte)

**Tip 4: PC users can right-click an image then choose "properties" to see resolution.**

Essential Graphic Design Concepts

Resolution: Where can you find file size?

![Image showing file size on a computer window.](image-url)
**Essential Graphic Design Concepts**

**Understanding Image formats**

- **Raster images** (TIFF, JPEG, GIF, PNG, PICT, BMP): These types of images are composed of pixels and are dependant on resolution for clarity (photos, line art, etc.).

- **Vector images** (EPS): These types are images are not dependant on resolution and can be enlarged without distortion.

---

**Essential Graphic Design Concepts**

**Vector Image**

This example shows you how you can modify a vector file by extending some of the anchor points.
**Essential Graphic Design Concepts**

**Good sources of image files**

- **Digital camera images** set at the highest resolution setting.

- **Slides or photos** that you can scan yourself. *(Tip: Scan at 300 dpi and scale [enlarge] images to final desired size during scanning stage.)*

- **Downloadable high resolution images.** *(Always remember to look into copyright permission when using photos produced by a third party.)*

**Essential Graphic Design Concepts**

**Scanning tips**

- When scanning line art or text, set your scanner to black/white, **NOT** grayscale. Image will print much more clearly.

- Scan photos/slides at 300 dpi and line art at 900 dpi.

- **Scale (enlarge) your images at this stage.**
  
  Ex: If you have to scan a slide, scale (enlarge) it up to 300%. That will enlarge the image to 3 times its original size at 300dpi so it will be **BOTH clear and larger.**
Essential Graphic Design Concepts

Typical Scanning Setup

- Output type
- Resolution (dpi)
- Scale

Downloadable high resolution images.

Bugwood.org
Essential Graphic Design Concepts

Bad sources of image files for print

• **Screen captures**
  Images on the Web are usually only 72 dpi. (Find out about copyright before using any online image, and be careful not to use images with watermarks.)

• **Cut or copied and pasted images**
  I do NOT recommend copying a pasting images from one software into another! The image quality will degrade every time this is done and the resolution is usually low.

Essential Graphic Design Concepts

What if the only photo you have is within a MS Word document?

I do NOT recommended copying/pasting images; however, if the clarity of the image looks good (**by that I mean NO pixels**) and the image is the only thing on the page, you can make a PDF of the page and insert the PDF into your document as a graphic. You can also print the image, scan it at 300 dpi and insert into your document as an image.

The quality won’t be as good as an original, high resolution image, but it may be adequate.
Essential Graphic Design Concepts

What if the only photo you have is within a PDF document?

If you have Photoshop, you can open the PDF, crop out the image and save the file as TIFF image. If you don’t have this software, you can print the page, scan it at 300 dpi and insert into your document as an image.

The quality won’t be as good as an original, high resolution image, but it may be adequate.

---

Essential Graphic Design Concepts

How to convert a PDF into a graphic file using Photoshop.

1. File > Open > filename.PDF. Make sure resolution is 300 dpi.
2. Select the photo with the Rectangular Marquee Tool.
3. File > Save As > TIFF format
4. Image > Crop
Essential Graphic Design Concepts

What image formats are best to use for print?

• **TIFF format** is preferred by the print industry for photos, etc.
  – If your project is going to be printed on a printing press all images need to converted to CMYK mode.

• **EPS, AI format** is preferred for illustrations.

Essential Graphic Design Concepts

What is CMYK and what is RGB?

The **CMYK color model** stands for Cyan, Magenta, Yellow and black. When a color photo is printed it is literally separated into these four colors and printed one color at a time. These four colors then combine to give you the full color image.

When a photograph is going to be reproduced on a traditional printing press or on today’s digital presses or color printers, photos should be converted to CMYK format prior to reproduction to ensure color accuracy.

The **RGB color model** stands for Red, Green and Blue. Files in RGB format are intended for use on electronic systems like TVs, mobile phone displays and computer monitors.

You’ve probably noticed that the colors of photos on different electronic devices often look different—that is because each device reads the color breakdowns differently. You don’t want this type of inconsistency in print.
Essential Graphic Design Concepts

How do I change a file from RGB to CMYK to prepare file for printing?

The only way to change a file from RGB to CMYK format is to use Photoshop.

You would go to Image > Mode > CMYK Color.

Also, remember to save the file in TIFF format.

If you don’t have this software, pre-press staff at your print shop will need to make the change for you.

Copyright and Fair Use

Copyright can be a confusing subject, but you can stay on the right side of the law by following a couple of easy rules.

Public Domain
Works in the public domain are not protected by copyright and may be freely reproduced. The two biggest categories are US Government works and works produced before 1923.

Even though they are not copyrighted, you should still provide a citation when reproducing public domain works.

Copyrighted Works
If a work is copyrighted, you may be able to reproduce it if your use can be considered “fair use.” Fair use can be tricky to determine, though. To be on the safe side, always request permission (in writing) from the work’s owner or copyright holder to reproduce any copyrighted work. If you’re unsure about whether a work is copyrighted, just assume that it is.
Questions and Answers

Thank you for participating in today’s webinar! We hope you’ve found it useful.